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Overview: What is TrashMan?
Microsoft Windows has a lot going for it.    But even recent releases of Windows, with their greatly 
enhanced file management capabilities, feels like their missing "something."    Namely, the literal 
cornerstone of the graphical interface - the trash can.

The solution?    Well, you can buy a Macintosh.    Or an expensive desktop replacement package.    Or 
you can save a ton of cash, headaches, and hassles by using Trash Manager with your existing 
hardware and software.

Trash Manager (often abbreviated with fondness to TrashMan) works hand-in-hand with the Windows 
File Manager you already own.    Drag files from File Manager to TrashMan and they're moved to the 
"trash" - a special storage area that gives your files a second chance.    From there, you can restore or 
permanently delete them... if and when you want to.    Because your "trashed" files stay intact, safely 
tucked away, even after exiting and re-starting TrashMan, Windows, or the computer itself.

TrashMan even takes advantage of Windows' new multimedia abilities.    You can easily assign your own 
sounds to different TrashMan events, realizing the ultimate in customization.

To put it simply:    With TrashMan installed, Windows is finally complete.    Don't trust your valuable data to
anything less.

TrashMan is not free software.    It is being offered through the shareware distribution method.    This is an
evaluation version which you are free to use for a period of thirty (30) days.    More information on 
shareware and registering your copy of TrashMan can be found in the Registration Information section.



Menu Items & Tool Bar Buttons
Double-clicking the TrashMan icon displays the TrashMan window.    The window contains two menus 
and a list of any and all trashed files.    The following are descriptions of the various menu items...

Menu Name Menu Item Name Menu Item Description
File Empty Trash Deletes all files stored in the trash.

Restore File(s) Restores ("undeletes") the selected file or files.

Select All Selects all files stored in the trash.

Options... Allows you to set a number of options for TrashMan 
such as: how to position the icon, whether or not the 
program should minimize on use, whether or not to 
delete trashed files immediately, and whether or not the 
program should warn about files pending upon exit.

Sounds... Presents a dialog box that allows the user to assign 
WAV format sounds to various TrashMan events.

Register... For newly registered users.    Presents a dialog box that 
allows entry of registration codes which "transform" the 
program into a registered version.

Exit Quits TrashMan.    If the program is not registered, a 
registration reminder dialog box is displayed before 
exiting.

Help Contents Brings up this Windows Help file.

Search for Help on... Search for help on a certain topic in this Windows Help 
file.

How to Use Help Brings up the "How to Use Help" help file from Microsoft.

About TrashMan... Tells the current version of TrashMan, displays a 
copyright notice, and reveals whether or not this copy is 
registered.    If so, the name of the registered user or 
entity is displayed.    Unregistered users will see a 
registration reminder dialog box.

Tool bar equivalents:



Using TrashMan
The following topics are available related to the use of TrashMan...

Trashing Files And/Or Directories 
Restoring Trashed Files And/Or Directories 
Emptying The Trash 
TrashMan Options 
Assigning Sounds To TrashMan Events 
Choosing A Font For TrashMan 
Menu Item & Tool Bar Button Descriptions 



Trashing Files And/Or Directories
Moving files and/or directories to the trash is known as "trashing" them, after which they are called 
"trashed" files and/or directories.    Files and/or directories are trashed by dragging them from the 
Windows File Manager to the TrashMan icon.

When files and/or directories are present in the trash, the TrashMan icon changes to appear "bloated" or 
"full," as a visual reminder that there are trashed files pending.

Trashed files and/or directories will remain in the trash (even after exiting and re-starting TrashMan, 
Windows, or the computer itself) until either the files and/or directories are restored or the trash is 
emptied.    To accomplish this, TrashMan creates a hidden directory on your hard disk to store trashed 
files and/or directories.    Whenever there are no more trashed files and/or directories to store (because 
they have been restored or the trash has been emptied), this directory is removed.

Files and directories can be deleted automatically upon being dropped onto TrashMan by setting a check 
box item in the Options dialog box.

NOTE:    Due to a problem with current versions of Windows, directories from the left side of the File 
Manager window cannot be trashed.    To trash directories, choose the root directory on the left side of the
File Manager and drag one of the directory items that appear on the right side of the File Manager 
window.

NOTE:    Files and/or directories from removable media (such as floppy diskettes) can be dropped onto 
TrashMan, but they will not be handled like other files and/or directories.    They cannot be stored in the 
trash.    You will be given the option of deleting the files and/or directories permanently or leaving them 
unchanged.    

NOTE: Files and/or directories from network drives cannot be trashed.    Please contact us for information 
on obtaining our special network version.

NOTE: Due to a problem with the current pre-release version of Windows NT, files and/or directories 
cannot be dropped onto TrashMan unless TrashMan is minimized.



Restoring Trashed Files And/Or Directories
To restore trashed files and/or directories, you must first select them.

Double-clicking the TrashMan icon displays the TrashMan window.    The window contains two menus 
and a list of any and all trashed files and/or directories.    Trashed files and/or directories are selected in 
essentially the same way normal files and/or directories are selected in the File Manager.    You can 
single-click to select an individual file and/or directory, single-click while holding down the Control key to 
select multiple files and/or directories, choose "Select All" from the File menu, or choose the "Select All" 
tool bar button to select all trashed files and/or directories.

Once selected, trashed files and/or directories can be restored (to their original position on your disk) by 
choosing "Restore File(s)" from the File menu or the "Restore File(s)" tool bar button.



Emptying The Trash
Emptying the trash permanently deletes all files and/or directories that remain in the trash.    This can be 
done by selecting "Empty Trash" from the File menu or choosing the "Empty Trash" tool bar button.



TrashMan Options
Always On Top

The "Always On Top" checkable menu item is available on the System menu (the menu that is activated 
by clicking the box in the upper-left corner of the window, clicking the minimized icon, or pressing Alt-
[Space]).    When this menu item is checked, TrashMan will 'stay on top' of other windows.    This item is 
checked by default.
 
The Options Dialog Box...

The Options dialog box is selected by choosing "Options..." from the File menu or the "Options..." tool bar 
button.    The dialog box allows you to set the following options for TrashMan.

Positioning The TrashMan Icon

Three radio buttons - "Auto Position," "Save Position," and "Windows Default" - control the positioning of 
the TrashMan icon.    By default, TrashMan automatically positions itself in the lower, right-hand corner of
your desktop. 

"Auto Position" - TrashMan can automatically position its icon in any of the four corners of the screen.      
When "Auto Position" is selected, another area of the dialog box activates.    This area, with four radio 
buttons in the four corners of a box representing your desktop, is used to set the desired corner for 
automatic positioning.

"Save Position" - The position of the TrashMan icon when the program is exited is used the next time it is 
started.

"Windows Default" - Lets Windows decide where to place the icon.

Minimize On Use

When the "Minimize on Use" check box is checked, the TrashMan window is minimized after being used 
(i.e., files and/or directories dropped on the window).    This item is not checked by default.

Delete Files Immediately

When the "Delete files immediately" check box is checked, files and/or directories are not stored in the 
trash when dragged to TrashMan; they are deleted immediately.    This item is not checked by default.
 
Warn About Files Pending On Exit

When the "Warn about files pending on exit" check box is checked, TrashMan warns you if files and/or 
directories are present in the trash before the program closes.    This item is checked by default.



Assigning Sounds To TrashMan Events
Selecting "Sounds..." from the File menu or choosing the "Sounds..." tool bar button brings up a dialog 
box that allows you to assign WAV format sounds to three different TrashMan events (trashing files, 
restoring files, and emptying the trash).

Each of the three events has an edit box (where you can directly type in the path to the sound you wish 
you use), a "Browse..." button (which brings up a file selection dialog box so that you can more easily 
locate and select a sound), and a "Test" button (to play the assigned sound).

NOTE:    In order to take advantage of this feature, you must have capable hardware and a waveform 
audio sound driver installed.    If you are unable to locate a driver for your system, contact Microsoft or 
your systems vendor for more information.



Choosing A Font For TrashMan
The font TrashMan uses to display the names of trashed files and/or directories corresponds to the font 
selected for file names and directories in the File Manager.    To change this font:

1) Exit TrashMan.
2) Start File Manager.
3) Choose "Font..." from the "Options" menu and select a new font.
4) Re-start TrashMan.



Technical Support and Customer Service
Both Trigon Software and CheckBox Software are dedicated to the complete and total satisfaction of our 
customers.    If you have any questions about or problems with this software, you are encouraged to 
contact us.    We will do our absolute best to help you.    

TrashMan was developed by Trigon Software of Germany.    Trigon Software offers technical support and 
other services to all registered users of TrashMan.    In addition, all questions regarding the status of the 
shipment of orders, refunds, registration options, site licenses, etc. in Europe and other areas outside of 
North America should be directed toward Trigon Software.    Trigon Software can be reached through the 
following channels:

CompuServe - 100021,2706
InterNet - 100021.2706@compuserve.com
Mail - Trigon Software GmbH, Flurweg 25, D-1000 Berlin 47, Germany
Telephone - +49 30 661 29 86
Fax - +49 30 661 56 35

TrashMan is distributed in North America by CheckBox Software.    All questions regarding the status of 
the shipment of orders, refunds, registration options, site licenses, etc. in North America should be 
directed toward CheckBox Software.    CheckBox Software will also be happy to provide technical 
assistance where possible and to forward any concerns or suggestions to Trigon Software.    CheckBox 
Software can be reached through the following channels:

CompuServe - 71034,2654
America Online - CHECKBOX
InterNet #1 - 71034.2654@compuserve.com
InterNet #2 - checkbox@aol.com
MCI Mail - TO: CheckBox Software (EMS) EMS: COMPUSERVE MBX: 71034,2654
AT&T Mail - mhs/c=us/ad=compuserve/pd=csmail/d.id=71034.2654
X.400 - Country=US ADMD=CompuServe PRMD=CSMail DDA=71034.2654
Telex/Twx - Machine No. 3762748 (On first non-blank line enter "TO: 71034,2654") 
Forem-Net - Mike Mezaros, Node 593
FidoNet - Mike Mezaros, Node 1:107/331
BBS - Z*Net News Service BBS (908) 968-8148, Conference # nine "CheckBox Software"
Mail - CheckBox Software, One Leary Drive, North Brunswick, NJ, USA 08902
Telephone - (908) 545-3010 10AM-4PM Eastern Standard Time
Fax - (908) 418-1441



Registration Information
Thank you for evaluating Trash Manager!

TrashMan is not free software.    It is being distributed as shareware, the software distribution method that
allows you to "try before you buy."    You are granted a license to use TrashMan for a thirty (30) day 
evaluation period.    After this period, you must either register the program or remove it from your system.   
We certainly hope that you will find the program useful and register it.

To register, you need to pay the required registration fee.    As a registered user, you will be granted a 
license for continued use of the software.    You will also receive a diskette containing the latest version of 
TrashMan along with several other utilities and a set of unique registration codes.

These registration codes will "transform" the program into a registered version.    The registered version 
contains no reminder screens and will display you or your company's name in its About dialog box.

Thank you for your support!

Please click one of the following topics for more information on registration:

I Am Located In North America
I Am Located In Europe Or Another Area Outside Of North America



Customers In Europe And Other Areas Outside of North America
Click here -> Trigon Software Order Form <- for an order form.
Then select Print Topic from the File menu to print the order form on your printer.
(If you don't have a printer, please write or type all pertinent information on a piece of paper.)

Registration Cost:    DM 43,00
Add DM 14,00 for shipping, handling, and VAT within Germany - total cost: DM 57,00.
Add DM 17,00 for shipping and handling outside of Germany - total cost: DM 60,00.

Payment is accepted in DM by cheque, money order, eurocheque, and Visa in DM.    No COD orders, 
please.    English and German language versions are available.

Please make cheques or money orders payable to "Trigon Software GmbH."

Enclose the proper payment and information and mail to:

Trigon Software GmbH
Attn: Ingo E. Czok
Flurweg 25
D-1000 Berlin 47
Germany

Or, if paying by Visa, you can fax your order to: +49 30 661 56 35.

Multiple and site licenses are available at discounted rates.    Contact us for more information.    Also, 
please inquire about our versions for Windows for DOS, Windows for Pen Computing, and networked 
systems.

Thank you for your support!    It is appreciated!



TrashMan for Windows NT Registration/Order Form - Via Trigon Software
Disk Format Preferred (Please Check One):
[ ] - 3.5"   [ ] - 5.25"   [ ] - No Preference
Please Check One:
[ ] - English Language Version   [ ] - German Language Version
Registration Cost: DM 43,00
Additional Fees (Please Check One):
[ ] - Within Germany, add DM 14,00 to cover the costs of shipping,
      handling, and VAT.  Total Order Price: DM 57,00
[ ] - Outside of Germany, add DM 17,00 to cover the costs of shipping
      and handling.  Total Order Price: DM 60,00
Payment Method (Please Check One):
[ ] - Cheque/Money Order/Eurocheque   [ ] - Visa
Total Order Price: DM____________
_____________________________________________________________________
Registration Name (Required; Will Be Displayed By Program)
_____________________________________________________________________
Your Name                          Your Title (If Applicable)
_____________________________________________________________________
Company Name (If Applicable)       Phone Number
_____________________________________________________________________
Address Line #1
_____________________________________________________________________
Address Line #2
_____________________________________________________________________
Address Line #3
_____________________________________________________________________
Address Line #4
_____________________________________________________________________
Visa Card Number And Expiration Date (If Paying By Visa Card)
_____________________________________________________________________
CompuServe ID Number And/Or Other E-Mail Address (Optional)
_____________________________________________________________________
Where Did You Find TrashMan for Windows NT? (Please Be Specific)



Customers In North America
TrashMan is distributed in North America by CheckBox Software.    For North American customers, this 
means that you will be dealing with CheckBox Software when it comes to placing your order, receiving 
your order, receiving updates, etc.    CheckBox Software will also provide technical assistance where 
possible and will gladly pass on any of your suggestions or concerns.

If you'd like to ask us a question or contact us for any reason, please see the Technical Support and 
Customer Service section of this file for information on how to contact CheckBox Software.

Please click one of the following topics for more information on registration:

North American Registration By Check Or Money Order 
North American Registration By Credit Card 



North American Registration By Check Or Money Order
Click here -> CheckBox Software Order Form <- for an order form.
Then select Print Topic from the File menu to print the order form on your printer.
(If you don't have a printer, please write or type all pertinent information on a piece of paper.)

Registration Cost:    $25.00 (US Funds)
Add $4.00 (US) for shipping and handling in the US or Canada - total cost: $29.00 (US).
Add $9.00 (US) for shipping and handling outside of the US or Canada - total cost: $34.00 (US).
New Jersey residents please add 6% sales tax (or use your credit card. to avoid sales tax).

Payment is accepted in US funds by check (cheque), money order, or postal money order.    Since it is 
virtually impossible to exchange small amounts of foreign currency within the United States, please make 
sure that any check (cheque) is in US funds drawn on a US bank (or use your credit card)
Please make checks (cheques) or money orders payable to "CheckBox Software."
Enclose the proper payment and information and mail to:

CheckBox Software
Attn: Mike Mezaros
One Leary Drive
North Brunswick, NJ, USA    08902

Multiple and site licenses are available at discounted rates.    Contact us for more information.    Also, 
please inquire about our versions for Windows for DOS, Windows for Pen Computing, and networked 
systems.

Thank you for your support!    It is appreciated!



TrashMan for Windows NT Registration/Order Form - Via CheckBox Software
Disk Format Preferred (Please Check One):
[ ] - 3.5"   [ ] - 5.25"   [ ] - No Preference
Registration Cost: $25.00 (US Funds)
Additional Fees (Please Check One):
[ ] - New Jersey residents, add $5.74 (US) to cover the costs of
      shipping, handling, and state sales tax.
      Total Order Price: $30.74 (US)
[ ] - Within the US or Canada, but outside of New Jersey, add $4.00 (US)
      to cover the costs of shipping and handling.
      Total Order Price: $29.00 (US)
[ ] - Outside of the US or Canada, add $9.00 (US) to cover the costs
      of shipping and handling.
      Total Order Price: $34.00 (US)
Total Order Price: $______________
_____________________________________________________________________
Registration Name (Required; Will Be Displayed By Program)
_____________________________________________________________________
Your Name                          Your Title (If Applicable)
___________________________________(____)____________________________
Company Name (If Applicable)       Phone Number
_____________________________________________________________________
Address Line #1
_____________________________________________________________________
Address Line #2
_____________________________________________________________________
City, State/Province, Country      Zip/Postal Code
_____________________________________________________________________
CompuServe ID Number And/Or Other E-Mail Address (Optional)
_____________________________________________________________________
Where Did You Find TrashMan for Windows NT? (Please Be Specific)



North American Registration By Credit Card
Visa, MasterCard, American Express, and Discover are accepted.
When ordering, please request Trash Manager Registration, Item Number 10555.
PLEASE SPECIFY "WINDOWS NT" VERSION.    Please specify 3.5" or 5.25" diskette.

Registration Cost:    $25.00 (US Funds)
Add $4.00 (US) for shipping and handling within the U.S. or Canada - total cost: $29.00 (US).
Add $9.00 (US) for shipping and handling outside of the U.S. or Canada - total cost: $34.00 (US).

Toll Free 800 Number (Within the United States):    1-800-2424-PSL (1-800-242-4775)

Regular Phone Number:    (713)-524-6394        Fax:    (713)-524-6398        CompuServe:    71355,470
Mail:    Public (Software) Library, P.O. Box 35705, Houston, TX, USA 77235-5705

IMPORTANT INFORMATION FOR CREDIT CARD CUSTOMERS:    Credit card registrations for 
CheckBox Software shareware products are handled through the Public (Software) Library.    The PsL 
is one of the oldest, largest, and most well-respected shareware disk vendors in the world.    To ensure 
that you are shipped the latest version of TrashMan, the PsL will notify us the day of your order.    Most 
credit card orders are then drop-shipped by CheckBox Software within 24 to 48 hours.    Please note that
the numbers and addresses above are for orders ONLY.    The PsL is not equipped to handle any 
other requests on our behalf.    If you have any questions, please see the Technical Support and 
Customer Service section of this file for information on how to contact CheckBox Software.



Legal Disclaimers and Notices
TrashMan is being distributed as shareware.    More information on the shareware distribution method 
and registering your copy of TrashMan can be found in the Registration Information section.

THIS PACKAGE (CONSISTING OF THE TRASH MANAGER FOR WINDOWS NT SOFTWARE AND ASSOCIATED DOCUMENTATION) IS PROVIDED "AS IS" 
WITHOUT REPRESENTATION OR WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
REPRESENTATIONS OR ENDORSEMENTS REGARDING THE USE OF, THE RESULTS OF, OR PERFORMANCE OF; ITS APPROPRIATENESS, ACCURACY, 
RELIABILITY, OR CURRENTNESS.    THE ENTIRE RISK AS TO THE USE OF THIS PACKAGE IS ASSUMED BY THE USER.    IN NO EVENT WILL TRIGON 
SOFTWARE OR CHECKBOX SOFTWARE BE LIABLE FOR ANY DAMAGES, DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL, RESULTING FROM 
ANY DEFECT IN THE PACKAGE, EVEN IF TRIGON SOFTWARE AND/OR CHECKBOX SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.    ANY AND ALL USE OF THIS PACKAGE, FOR ANY PURPOSE, WITH NO REGARD TO THE LEGALITY OF SUCH USE OR PURPOSE, IS THE 
COMPLETE AND SOLE RESPONSIBILITY OF THE USER.    ALL TERMS ARE SUBJECT TO CHANGE WITHOUT NOTICE.    THIS DISCLAIMER SHALL 
SUPERSEDE ANY VERBAL OR WRITTEN STATEMENT TO THE CONTRARY.    SHOULD ANY PART OR PARTS OF THIS DISCLAIMER BE DEEMED 
UNLAWFUL, THE REMAINDER SHALL STILL APPLY.    IF YOU DO NOT ACCEPT THESE TERMS YOU MUST CEASE USING THIS PACKAGE IMMEDIATELY.

THIS PACKAGE IS COPYRIGHT © 1992 BY TRIGON SOFTWARE GMBH AND IS THE SOLE PROPERTY OF TRIGON SOFTWARE GMBH.    DISTRIBUTION, 
ORDER-TAKING, AND ORDER FUFILLMENT IN NORTH AMERICA IS BEING HANDLED BY CHECKBOX SOFTWARE THROUGH SPECIAL ARRANGEMENT 
WITH TRIGON SOFTWARE GMBH.

THIS PACKAGE IS BEING DISTRIBUTED THROUGH THE SHAREWARE DISTRIBUTION METHOD.    YOU MAY DISTRIBUTE THIS EVALUATION VERSION 
FREELY.    ONLY VENDORS APPROVED BY THE ASP (ASSOCIATION OF SHAREWARE PROFESSIONALS) MAY DISTRIBUTE THIS PACKAGE FOR A FEE 
WITHOUT PRIOR PERMISSION.    (RECEIPT OF DISK FROM AUTHOR IMPLIES PERMISSION.)      SEE THE VENDOR.DOC FILE FOR MORE INFORMATION.

TrashMan and Trash Manager are trademarks of Trigon Software GmbH.
Windows and Excel are trademarks of Microsoft Corp.
Macintosh is a registered trademark of Apple Computer Corp.
All other trademarks are the property of their respective owners.






